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The MX/QX is the non-intrusive intelligent actuator of choice 
for users demanding safety, quality, ease of configuration and 
technology leadership. Flowserve Limitorque’s commitment to 
technology leadership is demonstrated in an available Bluetooth® 
option that permits a user to download or upload configuration 
routines via a standard low-power wireless communication 
path to an actuator. The MX/QX actuator can communicate via 
Bluetooth with a Bluetooth-equipped PC, PDA, or cell phone 
compatible with the Microsoft Windows® Mobile platform and 
the MX/QX Dashboard actuator diagnostics GUI (graphical user 
interface) software. This document outlines the flexibility of the 
Dashboard software.

The MX/QX Bluetooth option contains a Frequency 
Hopping Spread Spectrum (FHSS), which enables a reliable 
communication link, even in a “noisy” environment. The 
Bluetooth option also contains 128-bit data encryption to protect 
the privacy of the link. Bluetooth communication is accessible up 
to 10 meters (~30 ft.) from the actuator in all directions, and the 
ability to enable the Bluetooth communication link is password 
protected. When the Bluetooth link is enabled, a visible blue LED 
in the controls LCD window signifies that an active Bluetooth 
link to the actuator is established.

The Dashboard actuator software program permits a user to 
easily access either the configuration routines or the diagnostics 
capability of the MX/QX actuator using a Bluetooth-equipped 
PC or PDA with the Windows Mobile 5 platform. Dashboard 
is driven by GUI and parallels the menu selections of the MX/
QX (see Installation and Operations manuals LMENIM2306 and 
LMENIM3306). It can be used to change or view configurations 
up to 10 meters from the actuator when a Bluetooth link is 
established. A secure Bluetooth link must be established before 
configurations can be altered, ensuring security and safety. 
Once the link is established, Dashboard can be used to change 
or view the default configuration in either active online mode or 
background mode.

Online mode allows a user to make unit configuration changes 
in real time by simply answering “Yes” or “No” to the menu 
prompts. Exiting the program saves the changes to the  
MX/QX. These changes can be subsequently downloaded  
from a Bluetooth-equipped PC or PDA and uploaded to other 

MX/QX actuators that require identical configurations. This 
feature speeds the setup of the remaining actuators.

Offline mode allows a user to program a unit configuration, save 
the configuration to a PC or PDA, and upload into an  
MX/QX once the Bluetooth link is established. This feature 
enables the user to assign a unique configuration for any 
number of actuators in a non-volatile environment, save it to  
the computer device, and schedule the upload to the actuators 
when planned maintenance is performed.

Diagnostics can also be downloaded from the actuator into 
a PC or PDA via Dashboard and saved for further evaluation. 
Dashboard can be used to analyze this data or e-mail it to 
Flowserve Limitorque for evaluation.

These features are available up to 10 meters from the  
MX/QX actuator equipped with the Bluetooth (BT) option. 
Dashboard can also be used with the IrDA port supplied  
with each MX/QX unit. IrDA (IR) communication is limited  
to < 1m. It also requires a link to be established, but the effective 
communication distance is typically less than one meter to avoid 
cross-communication with neighboring devices. 

When the MX/QX software is revised, Dashboard can be used  
to implement newly released software and upload it to the  
MX/QX. It is recommended that the IrDA link be used to upload 
new software into the MX/QX actuator.

NOTE: This version supports only the ENGLISH language option.

About MX/QX Dashboard software 
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Dashboard is supported on the following computer systems:

•	 PDA	-	Microsoft	Mobile	5	or	6	operating	system	only	with	
Bluetooth and Infrared capability.

•	 Laptop*	-	Microsoft	XP® operating system with Bluetooth 
and Infrared capability. Microsoft Windows VISTA® not 
supported.

•	 Desktop*	-	Microsoft	XP® operating system with Bluetooth 
and infrared capability. Microsoft Windows VISTA not 
supported.

 *Internal or external Bluetooth or infrared devices supported 
on most PCs. Refer to manufacturer’s instructions for 
installation.

Dashboard is available free of charge when the MX/QX with the 
Bluetooth option is purchased, and it can be downloaded from 
www.limitorque.com or on CD.  

NOTE: A nominal fee is charged for Dashboard if used on the 
infrared equipped only MX/QX actuators. 

PDA Installation

1. Using Microsoft Active Sync®, copy the dashboard.cab file to 
the PDA directory of your choice  .

2. On the PDA, open the folder where the .cab file resides and 
select it.

3. Follow the installation instructions (Windows Mobile 
generated).

NOTE: Dashboard .cab files for the PDA are provided as 
Widcomm or Wincomm versions. If the program generates an 
error after installation, the incorrect version was installed. 

PC (non-PDA) Installation

1. Insert the CD in your PC CD drive.  

2. Open file explored and select the setup.exe from the CD drive 
directory.

 

3. Click OK and follow the installation instructions.

Dashboard (PDA or PC) is encrypted and requires a key to 
unlock the encryption. When the Dashboard software is first 
activated on your device, a keycode will appear. For example: 

•				Dashboard	Keycode	=	7790793D6995DD8

This keycode is then used to generate a random key to unlock 
the software. For example:

•				Dashboard	Key	=	699907DD893705D

Each key code is unique for every PC and PDA; therefore, the 
end user must obtain a key code for every installed platform.

Once the key is validated, the end user must accept the terms of 
the agreement prior to first use.

The key to unlock the code is available from the factory by calling 
434-528-4400 and asking to speak with a service representative.

installing and Activating Dashboard
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To configure the MX/QX “port” setting, refer to the 
LMEIM2306/3306 for detailed instructions.

To use the MX/QX Downloader option on the dashboard, the 
MX/QX must be configured for IRDA in the “port” setup.

The ModSim option on the Dashboard is supported either  
via IR or BT.

Setup example for the IR setting in the “port” menu:

 

Once the port is configured, Dashboard may be used to 
communicate with the MX/QX via the user selected Local port. 

Note: When using the IR option, line of sight is required with  
the device. For best results hold the IR device approximately  
12 cm or less, from the actuator. BT option supports a 
maximum distance of 10 meters from the device.

Configuring the MX/QX BT option:

•				In	the	‘ports’	menu,	select	the	BT	port.

•				Each	BT-equipped	MX/QX	has	a	unique	identifier.	Note	for	
future reference.

•				Configure	the	BT	password.	Default	is	“default123456789,”	a	
maximum of 16 alphanumeric characters.

•				The	user	has	the	option	to	disable	the	password. 
NOTE: Limitorque strongly recommends the use of a 
non-default password on the MX/QX for security reasons.

•				The	MX/QX	is	now	ready	for	use	with	the	Limitorque	
Dashboard application.

MX/QX configuration
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This document is designed to demonstrate the capabilities 
of the Bluetooth link for communication with the MX/QX. IR 
communication is identical except for the initial selection of the 
IR/COM link. From this point forward, the BT link shall be used 
as a reference.

The link is established per the following procedure:

•				Verify	the	MX/QX	is	configured	for	the	BT	port	option.

•				Record	the	MX/QX	password.

•				Using	the	Dashboard	application,	perform	the	following:

 -    Select the “Bluetooth” button.
 

 

The Dashboard application will scan for all BT devices in range.

NOTE: The application will identify all BT devices in range 
including and not limited to cell phones and PCs. 

Note: The FLXMX/QX refers to the MX/QX actuator.

•			If	the	desired	actuator	does	not	appear	in	the	scan	window,	
move closer to the actuator and press the “Rescan” button.  
If the actuator still does not appear in the scan window, 
verify the MX/QX actuator in question.

•			Select	the	desired	actuator	with	the	mouse	cursor	(PC	
application) or stylus (PDA application) and wait for  
the “ACCEPT” button to activate.

NOTE: If the MX/QX is configured for password protection, enter 
the password in the Dashboard input field when prompted.

Proceed to page 9.

 

creating the Dashboard Bt Link
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The Dashboard offline mode allows the user to configure the 
MX/QX configuration prior to the system upload. The user is 
allowed to change parameters associated with a standard  
MX/QX configuration such as REMOTE mode, LOCAL mode, 
ESD,	etc.	Factory-set	parameters:	VOLTAGE,	FREQUENCY,	 
UNIT SIZE, UNIT SPEED, LIMIT SWITCHES are not configurable 
using Dashboard, thus allowing the user to upload a desired 
configuration to similar installed MX/QX’s without the risk of 
altering factory-set “as built” configuration.

To access the offline mode, perform the following as illustrated:
 

The “Offline Mode” must be checked.

•	 Once	the	“Offline	Mode”	is	selected,	the	“GO”	button	will	
activate. Select and proceed to page 9.

Dashboard offline Mode
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This section describes the available configuration options 
applicable to the MX/QX. The below illustrations are applicable 
to the offline and online modes.

Once in the Welcome screen below, proceed with the MX/QX 
configuration detailed below:
 

In the OFFLINE mode, the following user access is available:

 File > Exit – Exits the offline mode

 Target > Compare – Allows for saved file comparison

 Options > Download – Opens the MX/QX Downloader   
 application

 Options > Modsim – Opens the Modsim application

NOTE: All other links are not accessible.

 

In	the	ACTIVE	mode,	the	following	user	access	is	available:

  File > Exit – Exit the online mode

  Target > Config > Download – Downloads the MX/QX   
 configuration

  Target > Config > Upload – Uploads a configuration to the  
 MX/QX

  Target > Config > Compare – Compares the saved   
 configuration to the recently downloaded configuration

  Target > Reset – Resets the MX/QX resulting in a lost link

  Options > Download – Opens the MX/QX Downloader   
 application – IR OPTION only

  Options > Modsim – Opens the Modsim application; can be  
 used with BT or IR

NOTE: All other links are for factory use only.

MX/QX configuration via Dashboard
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This section describes the options and data available using 
the Dashboard application. Data includes Frequency Domain 
Analysis (FDA), diagnostic information including motor 
temperature, encoder status and firmware version information.

To access the detailed data, perform the following once a link  
is established:

WARNING: For safety reasons, configuration changes require 
REMOTE-STOP-LOCAL switch position in the “STOP” mode.  

Press	VIEW	in	the	WELCOME	screen	and	observe	for	below	
operation.
 

The user has a choice of pressing ABORT; once the read cycle  
is completed, the ABORT button changes to OK. 

 

Once the register data download is completed, the next display 
is as follows:
 

In the Configuration Selection, the end user has the option to 
change the following parameters [COMMIT button saves the 
desired changes]:

CONFIGURATION SELECTION OPTIONS: Configuration follows 
menus in the MX/QX 10 MS. Consult 10M. 

Valve setup 

Allowed changes: CW (Clockwise to Close) or CCW (Counter 
Clockwise to Close), Torque or Position seating.
 
     

 

MX/QX configuration Detailed 
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torque setup

Allowed changes: Torque % value from 40-100% [contact 
Limitorque before increasing torque values as the actuators  
are configured for the desired torque output at the factory].

 

Position Limit setup

Note: Encoder values are read only. Precision parameter is  
the only allowed change.

 

Modutronic setup

Allowed changes: Modutronic Enabled/Disabled, Proportional 
Band, Dead Band, Fail Action, Position, Polarity, and Delay After 
Stop.

 

network setup option

Allowed changes: Refer to specific protocol documentation 
for detailed information. If a network option is installed, the 
appropriate network type will be displayed. Protocols supported:  
Profibus DP/PA, DeviceNet, Modbus or Not Installed.
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status and Alarm configuration (relay) option

Allowed changes: S1-S2, R1-R8 – option dependent [allows for 
installed relay changes involving Trigger and Action].

 

two speed timer configurations

Allowed changes: Timer Enabled/Disabled, Start and Stop 
positions (in %), Pulse Time On (max 20 sec), Pulse Time Off 
(max 200 sec), Open or Close.

 

Analog out configuration option

Allowed changes: Function (APT, ATT, Restricted), Output 
(Current,	Voltage),	Offset	(4-20ma,	0-20ma),	Polarity	(20ma-
OPEN, 20ma_CLOSE), Enable/Disable.

 

remote control configuration

Allowed changes: Modes; 2-wire OPEN, 2-wire CLOSE, 3-wire 
INCHING, 3-wire MAINTAINED, 4-wire, Remote User Input, 
type; Multi-Control Mode; Digital or Network or Analog control 
[refer to the MX/QX LMENTB2300 documentation for detailed 
information].
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Local control configuration

Allowed changes: Local Control Enable, LED color reversal.

 

esD (emergency shutdown) overrides configuration

Allowed changes: User selectable defining the degree  
of protection required when using the ESD function.

 

inputs configuration

Allowed changes: Input 0, 1, 2 (ESD, OPEN/CLOSE Inhibit, BOTH 
Inhibits, User Input), Input enable/disable, ESD action, ESD set 
(Ignore, Open, Close), Inputs 3-5 are for future implementation.

 

Monitor relay configuration

Allowed changes: Local switch position (Local, Stop), 
Overtorque, Inhibit, ESD, non-configurable features are  
THOL (over temperature), Jammed and Overtorque.
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reset Diagnostics option

Allows for establishing a new baseline for the OPEN and  
CLOSE cycles.

 

Unit tag configuration

Allowed changes: Maximum of 8 alphanumeric characters 
recommended.

 

Password configuration

Allowable settings: 000-999 [setting the password to 000 
bypasses password protection; default is 100].

 

torque Boost configuration

Allowable settings: AUTO, ON or OFF. Recommended  
setting is AUTO.
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Motor thermostat configuration

Allows for enabling or disabling motor over temperature 
protection [recommended setting is Enable Motor Thermostat].

 

Valve Data configuration

Allowed	settings:	Valve	Serial	Number,	Valve	Model	Number	and	
Valve	Type	(linear,	rotary,	other,	undefined).	[Valve	data	should	
be obtained from the valve manufacturer.]

 

 

Port configuration

Allowed settings: IR (infrared - required for firmware download, 
BT-optional (Bluetooth), Disabled.

The Bluetooth option settings include BT name, password, 
discoverable and security option.
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Backup Power configuration

If equipped with this option, the recommended setting is to 
enable backup, power which allows for viewing unit position 
information when the main power is removed.

 

Language selection

Allows for language selection [supported languages listed in the 
picture below].

 

NOTE: To save the configuration in the Change Settings, select 
COMMIT.
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This section describes the diagnostics available via Dashboard.

To access the diagnostics, a BT or IR Link must be established.  
This function is not available in the offline mode unless viewing 
a saved file. The “Diagnostics” page displays a drop-down menu 
of available data as displayed below.
  

 

Example diagnostic selections are provided as a reference 
below:

 

 

MX/QX Diagnostics
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FDA is available on all MX/QX actuators supporting the BT 
option. The BT option is not necessary to obtain the FDA data.  
The data collection function is available via IR. Refer to the  
MX/QX documentation for detailed specifications. 

To	proceed	to	the	FDA	Manager,	select	VIEW	from	the	
DIAGNOSTIC Tab in the WELCOME screen. Follow the prompts.  
Once the file is downloaded, the FDA Manager is visible and 
available for data collection. To initiate the initial read, proceed 
to the FDA tab in the FDA Manager. NOTE: In the display 
window, “Run unit to collect needed data” operated the actuator 
in LOCAL or REMOTE mode in between the limits. In order to 
collect the valid data, the MX/QX actuator must be stroked from 
the OPEN to CLOSE when prompted. [Limitorque recommends 
obtaining the initial, first installed signature of the actuator.] 
 

 

Once the FDA data capture is complete, the display will  
be as follows:

 

At this point, the FDA data is available for viewing. Limitorque 
recommends the captured data be saved for future reference for 
comparison analysis.

NOTE: SPEED DATA in the Speed tab is available by performing 
the same procedure as the FDA. 



19

FCD LMENIM2338-01

Proceed to selecting “GET FDA” and the following screen  
should appear:

 

Once the read completes, proceed with viewing the trace  
data. NOTE: The file is saved in a Limitorque proprietary  
format. Dashboard is the only utility available to view the  
data at this time. The FDA and SPEED analysis is available  
for data recording.
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Viewing trace Data 

Selecting	View	Trace	Data	will	result	in	the	following	display	
presuming valid collection of data. The FDA Trace supports  
data comparison to an existing saved file.

FDA Trace

 

Speed Trace

 

FDA and sPeeD Analysis explanation

The values for the X-axis are in RPM. The values for the Y-axis 
are the relative magnitude of the power that the various rotating 
components of the actuator are developing mechanically over 
the speed ranges. If the magnitude at any given RPM changes 
from the stored baseline FDA, then compare the x-axis RPM 
for the suspect power magnitude against the expected working 
RPM for the components in the actuator. Any component that 
is expected to operate at the suspect RPM could be at risk 
of excessive wear, and the actuator should be included in a 
targeted preventive maintenance program. The suspect parts 
could be ordered in advance of the preventive maintenance to 
ensure that the downtime will be minimized.

Note: At the current time, the power magnitudes are relative 
values.

Operation Log lists parameters associated with the MX/QX 
operation since the last reset. This function is a real-time log.
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Analog Board summary status (MX/QX option)

If optional analog boards are installed, the operational  
status of the boards is displayed in real time.

 

 

Mainboard Version Display

The data display pertains to the MX/QX Main Processor  
Board indicating the boot, software and CPDL versions.

DDc Board summary status

If equipped with this option, the status of the Modbus  
board is provided.
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Position encoder

The MX/QX actuator utilizes a unique encoder design consisting 
of absolute and incremental encoders. The  
diagnostic data provides the real-time status of the encoder  
at the time of evaluation.

 

relay summary status

If optional relay board is installed in the actuator, the  
operational state of the board is provided. The standard  
relays consist of S1 and S2 relays. R1-R8 are optional.

 

 

Motor thermistor

This table provides real-time information since the last reset.  
The temperature in Therm 1 represents the present motor 
temperature; Therm 2 displays the highest temperature  
recorded during any operation.
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The Dashboard is provided with two utilities that allow for the MX/QX firmware update 
and detailed troubleshooting. The utilities consist of the MX/QX Downloader and the 
Modsim (Modbus Simulator) software for easy troubleshooting.  

An additional mode (Engineering) is provided for Limitorque personnel only.

MX/QX Downloader

The MX/QX Downloader is available only when using the IR option. The downloader 
can be used for the SMT (non-BT-compatible MX/QX) and the BT-compatible MX/
QX’s. For use with the BT-compatible MX/QX, the “Default bps” must be checked; for 
SMT, do not check the “Default bps.”

 

Please change this view to display the latest version of the MXa. 

Additional Utilities 
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The Modsim utility allows for internal diagnostics of the MX/QX actuator. This option can be used with BT  
(if equipped) or the standard IR port. The Modsim utility is compatible with the SMT (non-BT-compatible 
MX/QX) or the BT-compatible MX/QX.

 

For detailed register information, refer to the MX/QX Modbus Manual LMENIM2329-00. If additional support 
is required, please contact Limitorque service at 434-528-4400.
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This section details troubleshooting information associated  
with Dashboard to the MX/QX communication.

Link Lost error

This message is displayed if the MX/QX is reset, IR is out  
of range for more than five seconds, or the BT is out of range.  

NOTE:	Variable	Frequency	Drives	interfere	with	the	IR	
connection, resulting in a “Link Lost” message if already 
connected.

 

request Denied

This error is observed when the connection is terminated  
by the user clicking the RESET function. The link must be 
established for additional MX/QX diagnostics to continue.

troubleshooting
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LMENIM2306 – MX Installation and Operation Manual

LMENIM4019 – Direct to Host Manual

LMENBR2300-00 – Technical Bulletin, Protection/Control/
Monitoring Features

LMENIM2329-00 – MX DDC Manual (register detailed 
description)

LMENIM3306-00 – QX Instruction and Operation Manual

For additional documentation, go to www.limitorque.com  
and type “MX” and or “QX” in the Search window.

supporting Documentation
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